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Adding pages to your document 
  

First, open the DontBreaktheGrid.indd document you created last time. 

At the moment your document only contains one page. In order to add additional pages to your document 

you have multiple options. We will only show 3 ways in this manual. 

• First you can add a single page by going to Layout in the top menu and choose Pages and Add Page. 

This will add a page after the one we already have. 

 

To go to the next page, either scroll with the mouse wheel or use the page control option in the 

lower left corner of InDesign.  

• If you need to add multiple pages to your document. You could use the Insert Pages option, located 

in Layout>Pages>Insert Pages. 

 

 

This will open the menu shown below.  

 

 

Here you are able to add multiple pages and also be able to select where these pages should be 

inserted (Before Page, After Page, Start or End of the Document). 

 

• Another way of adding pages is the Pages Palette. If the Pages Palette isn’t available go to 

Window>Pages to activate it. Move it to the Palette. 

Opening the Pages Palette will give you the menu shown below. 
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Here you will be given a small overview of your document. In this example we only have a single 

paged document.  

 

To add more pages, simply right click inside of the area which contains the preview of the first 

page. Right clicking gives you the options to Insert Pages and will present you with the same menu 

as Layout>Pages>Insert Pages does. 

You could also press the Create new page symbol  in the bottom. This automatically inserts a 

new page after the first one, like shown here.  

 

By using one of the above mentioned methods, add a second page to your document. 
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Pictures and Text wrapping 
 

Go back to page 1.  

The Course 2 folder you have downloaded from CampusNet contains a picture called Learning.jpg insert 

this picture through File>Place or by using Mini Bridge. 

Place the picture so it spans across your four columns and fits the lower half of your page, like shown 

below. 

 

It might be necessary to drag the bottom of the frame up a bit to get it to fit the page.  

Also remember to right click on the image and choose Arrange and Send To Back, moving the picture 

behind all other elements on the layer. This makes us able to see the text that floats within our picture.  
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While text wrapping is already shown in the top menu, it is still a good idea to include it in the palette, as it 

has more options to it than the top menu shows. 

 Text wrapping in the top menu. 

Add Text Wrap to the Palette, by going to Window>>Text Wrap. Move it to your Palette. 

In this first example we would like to move the text away from the image. To do this open the Text Wrap 

Palette.  

  Text Wrap Palette. 

Right now your image has no text wrap to it. Try clicking on the Jump to next column  while the outer 

frame of the picture is selected. This setting removes the text that floats inside our picture and places it in 

the red plus shown below. 

 

Click on the red plus and go to the second page and drag a new text box that fits about half the upper page. 

Go back to first page and select the learning picture. Once again open the Text Wrap Palette.  

Underneath the text wrapping option we have the Offset options. 

 

 

By raising the Top Offset field to 2 mm you might notice a thin blue line rising up from the picture. This is 

the offset line. This line affects other elements above the image. In our example it will move some of our 

text to the second page, creating a small area of space between picture and text. 

 



 

IKT - Advanced Multimedia 

Group 

Marts 2011 

 PERT 

 

 

Side 7 af 40 

If all your offset fields change when you try to increase one value field, please make sure that the link 

symbol in the text wrapping menu looks like this.    

 

Ignoring text wrap 

 

Even though text wrapping is enabled on the picture it is still possible to place text on top of it, which we 

will go through next.  

First, choose the text tool and notice that it isn’t possible to draw a textbox inside the picture frame. 

Instead, create a small text box outside of the work space. Write “Try This!” in the text box. Set font size to 

18 and make it bold and italic.  

 

Next, place the text box on top of your picture. Notice, that only the frame will be visible as well as a red 

plus. The plus is shown as this text box also gets affected by the text wrapping settings we did earlier.  

 

In order to make the textbox ignore the text wrapping right click while having the text box selected and 

choose Text Frame Options. This will give you this menu.  

 

 

In the bottom of this menu we find the Ignore Text Wrap option. Please enable this setting. You should now 

be able to see the text on top of the picture.  

Save your document. 
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Wrapping around rotated graphic 

 

Go to the second page and make the text split into 2 columns.  

Use the Retangle Frame Tool  to create two boxes in between column 2 and 3 centered in the Gutter, 

follow the example underneath.  

Hint: Go to the selection tool and you will be able to copy the first frame by holding down the ALT Key 

while dragging the frame downwards.  Place the new frame underneath the first. 

 

Next, rotate the first box to 12 degrees to the right. Rotate the second box to 4 degrees to the left.  

 

 

 

Select the first frame and Place the picture Strawberries.jpg here. Place the picture Salad.jpg in the second 

frame.  

 

Select both frames by selecting one of them and then hold the Shift key while selecting the second one.  

Hint: The easiest way to select them is by clicking inside the gutter. 
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Use Fill Frame Proportionally and Centre Content on both pictures. Also give them a black solid Stroke with 

a weight of 4 pt.  

 

While still having the pictures selected open the Text Wrap Palette and select the Wrap Around Bounding 

Box . This setting moves the text that floats behind our pictures and places them in regards to the offset 

settings. 

Make sure that the link option is.  

Then, try to increase the top offset value to 3 mm and notice that the others tag along. 

 

See the result underneath.  
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As you might notice, the text wrapping mostly affects the text to the right of the pictures. If we were using 

another alignment setting for our paragraph, for instance the Justify with last line aligned left setting  

the text to the left will also be wrapping in a more consistent manner than it is now. See example below.  

 

  

Wrapping transparent objects 

 

To begin with, make a new text box that fits the lower half of your second page and right click to fill it with 

Placeholder text. 

Next, go to Place>File and locate the file Badge.psd, a Photoshop file. Place this file by dragging a frame 

that spans 1 ½ column inside our new text box like shown below.  
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Notice that this image has transparency to it.  

 

While having the graphic frame selected open the Text Wrap Palette.  We want the text to wrap around 

our image in a kind of a circle.  

To do this, we will use the Wrap around object shape   symbol.  

 

Your document should now look somewhat like this.  

 

In the bottom of your text wrap menu you’ll find the Contour Options. Here, we are able to choose the 

most suitable contour option for our graphic. Set the Type to Detect edges. 

InDesign will then detect the edges within the graphic and wrap the text around it. 

 

Hint: Be aware that this is only applicable in transparent graphic, including Photoshop and Illustrator files. It 

won’t work on .PNG24 files with transparency.  

 

 

Right now your document should look like this. However, we are still a bit away from the result we are 

looking for.  
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Above the Contour Options we have the Wrap To option. 

 

This menu lets you control where the text wraps.  

Try choosing both Right side and Left side.  

  

In this example Right side is the most suitable. However, in case we move our graphic to another location, 

the Right side wrap properly isn’t the best choice. Instead choose Wrap to: Largest area. This will allow the 

graphic to detect which side has the largest available area and wrap the text around your graphic here.  

First, the wrapping might looks like the Right side setting, but try moving it around and notice the text, 

wrapping differently around your graphic.  

Place the graphic as seen below.  

 

Meanwhile, this isn’t perfect yet. In order to get a better rounded looking wrap, try to enhance the Top 

Offset a couple of millimeters until the wrap looks good.  
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As we only have one surface on our graphic, it is only possible to change the Top Offset setting. 

 

Again, as we change the Offset setting a thin line appears around the graphic.  

 

 

This ends our wrapping session. So please save your document.  
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Master Page 

 
The Master page (or Pages) is a sort of template that you can apply to one or more pages in your 

document.  It works in the same way as the header and footer does in Microsoft Word. However, the 

master page lets you design the whole page and not just header and footer. Using Master Pages will make 

it easier to create longer documents with consistency.  

To access the Master page you can either go to the bottom of InDesign and click on the “drop up” box like 

shown below and choose A-Master. 

 

 

Or you can go the Pages Palette and click on the A-Master.  

This gives you two facing pages as shown below, resembling a newspaper or magazine. 

 

In these facing pages you are able to design your Master.  
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Page numbering 

 

For this example we wish to add page numbering to the Master, so we can apply it to our document. 

 Use the Retangle Frame Tool   to create a frame in the bottom corner of the left page.  

 

With the selection Tool select the frame. Then go to Text Tool and click inside the frame. Next you go to 

the top menu in Type>Insert Special Character>Markers>Current Page Number.  

This adds an A inside your frame, as the A is based on your A-Master. 

 

Center this A and changes the font to Verdana and give it a font size of 14 and make it italic.  

If we applied the Master page to our document now, it will only show the current page number on every 

left page.  

The easiest way to apply this on the Right page as well is to use the Selection Tool and hold down the ALT 

key while you drag your frame to the bottom of the page to the right. 

  

As default the Master will be applied to your document.  

Go back to your document, by opening the Pages Palette and double-click on the second page in the 

preview. Now there should be a page number in the lower left corner.  

 

The page numbering will not be visible on the first page as we have placed an image on top of it. 

Be aware that you can create multiple Master pages. This makes sense in the case where different pages in 

the same document need different layout settings. 
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Adding new Master can be done in the top of the Pages Palette by clicking the dropdown menu like shown 

below and choosing New Master. 

 

 

Save your document. 
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Creating a Cover page 
 

Cover creation involves most of the tools that we previously used. Our goal is to make a cover similarly to 

the one below.  

 

Here’s what you do: 

1) Add a new page before the first page.  

Open the Pages Palette and use the dropdown menu and click Insert Pages. 

You will get this menu. 

 

It is important that you change Insert to Before Page and it should be inserted before page 1.  

As we are working on the cover page, there is no need to apply the Master to it, therefore 

choose [None]. 
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This will add another page in our Page Preview in the Pages Palette. 

 

 

2) Create a frame that fits the entire page and afterwards place the picture Cover.jpg in it.  

         �        

 

Use the Content Centre to center the content.  

 

 

3) Next, make a frame that spans across the entire width of the page but in height only fits most 

of the backside of the laptop.  

Fill it with White color.  

 

We also need to decrease the Opacity of the picture to make it somewhat transparent.  

The opacity option can be found in the top menu.  

Set the opacity to 45%. 

 

It is important that the white frame is still selected while you change the opacity.  

 

4) Next, we need to Place the premade ICTmagazine logo located in your folder as ICTmag.psd. 

With the picture attached to our cursor, click just outside the document but still inside your 

workspace to place it in its true proportion. If we click inside our transparent frame, our logo 
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will also be given 45% opacity. 

 

Move the logo to the top of the document and try to make it fit like the picture below by 

scaling and/or moving it with your Arrow keys.  

 

 

5) Adding additional information like website address and edition no.  

 

Make a text box, which aligns with the red magazine rectangle.  

 

Type in www.ictmagazine.com and March 2011. Make sure that the address aligns left and the 

edition right. 

 (You’ll have to use the TAB key between the address and the edition to align differently). 

 

Give the text proper font type and size.  

 

 

 

6) Add a head Teaser to the document.  

 

A good idea is to create a teaser that explains why this picture is on your cover. Of course this is 

because he is so addicted to InDesign that he can’t leave his laptop to go to the bathroom ☺. 

 

Hint: The rule of thumb is to place the teaser in an area where it will have least impact on your 

image. Also make it larger than any other teasers, as well as giving it another font than the logo 

in order to make contrast. Contrast will attract your eyes to the Magazine.  

 

Make a text box in the middle of the document. 



 

IKT - Advanced Multimedia 

Group 

Marts 2011 

 PERT 

 

 

Side 20 af 40 

 

 

Type in “Addicted to InDesign?” 

- Change the font type to Stencil  

- Set font size to 60 and align center. 

 

 

 

While having all text selected double-clicking on the Fill symbol in the text box.  

- Add a Yellow color to the text. 

- Also add a Red stroke to the text by double-clicking on the Stroke symbol.  

 

 

- Set the Leading to 48 pt.  

- Also enhance the A in ADDICTED to size 72 pt.  

 

- Last but not least, the text needs a shadow effect to make it stand out from the picture.  

Select the frame of the text and go to the top menu and use the Shadow icon.   

  

 

7) Add a sub-teaser to your head teaser.  
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Create a text frame underneath the head teaser.  

- Change the font type to Stencil and size to 48. 

- Write “Meet Paul!” 

- Color it Red and the stroke Black 

- Place it underneath the question mark and rotate it.  

 

 

 

8) Finally, add the Barcode.jpg image to the cover. Place it in the bottom left corner.  

 

You have now made your first cover page in InDesign. 

Save your document. 

For additional information on how to create a great looking cover, visit  

http://layersmagazine.com/magazine-cover-design-in-indesign.html 
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Table of contents 
 

This section shows you how to create a table of contents. 

Before adding the page where our table of contents will be made, go to page 2. 

We are working on a magazine and in a magazine you’ll normally only include titles in the table of contents, 

but as we only have one title we’ll be creating sub-headings in our article that can be included in the table 

of contents.  

 

Sub-headings 

 

Select a line somewhere in the body text. Be sure to make a line space before and after the line, before 

making it a sub-heading. 

 

 

 

Go to the Paragraph Palette. 

  

- Reset the First Line Indent Left to 0 mm.  

- Increase the Space Before to 5 mm.   

- Also make the line Bold. 

This makes our soon to be sub-heading stand out of the body text. 

Next, go to the Paragraph Styles Palette.  

 

Create a new Paragraph Style and name it Subheading. 

Go to page 3 and make two additional subheadings.  

 

Insert a page after the cover page. Do not apply the Master page to it.  
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Now, go to Layout in the top menu and in the bottom you will find Table of Contents.  

This will open the menu below.  

 

Here you have a lot of different options. We will only focus on some of them;  

1. First, set the Style to TOC Title (Table of Contents = TOC). 

 

This is the preset style for the Title in our TOC.  

 

2. Then, you use the >> Add button to move Title and Subheading to the Include Paragraph Styles. 

Make sure that the Title is above subheading, otherwise drag it up. 

 

3. In the Entry Style option, use TOC Body Text.  This should be done while having Title selected in the 

Include Paragraph Styles menu. Repeat this for the Subheading. 

 

 

Make sure the Create PDF Bookmarks is checked like above.  

Press OK.  

Now you can place your TOC by clicking or dragging a Text Frame. 
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Click in the top of the second column and make it fit the two middle columns.  

 

Now you have created your first Table of Contents in InDesign.  

The TOC Styles have been added to your Paragraph Styles Palette and you can change them however you’d 

like.  

 

Try aligning the TOC body text to the right.  

 

 

While the selection is still active, right click on the TOC Body Text and choose Redefine to save these 

settings.  

Save your document. 
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How you export to PDF (Print) 
 

To create a PDF in InDesign go to File and choose Export. 

 

Save your project as Magazine_Print. Make sure the File type is set to Adobe PDF (Print) 

 

A new window opens with a lot of different options in regards to the PDF file you about to create.  

In order to make your Bookmarks active in the PDF you need to tick the Bookmarks and Hyperlinks options 

under Include.  

 

Also tick View PDF after Exporting to control the PDF right away. 

Press Export.  
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How you export to Flash   
 

If your goal is to use the document as interactive content online, InDesign allows us to export to flash, also 

called a .swf file. 

Meanwhile, if we export the document now it includes facing pages in the flash file. This isn’t desirable as it 

will display blank pages next to our cover and last page. See example below. 

 

Accordingly, we need to allow our pages to shuffle and then move up the second page, so none of the 

pages face each other. 

  �  

Allow pages to shuffle by going to the Pages Palette and use the dropdown menu and remove the check-

mark besides Allow Document Pages to shuffle. 
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Then you click and drag the second page up to the right side of the cover page, move it around until a 

straight black line appears besides it and then let go of the mouse button.  

  

Now none of the pictures should be facing each other and we are ready to export to flash. 

 

The procedure is very similar to the PDF export.  Go to File>Export. 

Name your file Magazine_swf and make sure to change the file type to Flash Player (SWF). Press Save.  

 

 

Another menu appears after pressing save. This is the Export SWF menu. 

 

 

Among others this menu lets you choose the pages you will include in the flash file as well as the size of it.  
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In our example we are interested in scaling down the flash file to a resolution of 800x600 so it will fit in 

most browser windows.  

When having done so, press okay. After saving it will automatically show the result in your default browser.  

 

Control the flash file to see if you are able to flick through the pages and that the bookmarks are active.  

Save your document and close it. 
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How you create a flash animation 
 

In this animation exercise we will walk through how you create an interactive flash document.  

This section will show you how you can create a slideshow and enable interactive buttons and how you 

make objects move. The idea is to give you a sense of the possibilities of animating in InDesign, without 

having to write any codes what so ever.  

First, we need to create a new landscape document intended for web, with 2 pages and 1 column.  

 

Press OK. 

Next we need to change our Palette type from Essentials to Interactive to get the right tools.  

Go to the top menu and click on the downwards pointing arrow besides Essentials and select Interactive. 

Notice the Palette changes and includes new tools.  
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We are now ready to begin animating. 

 

 

Animating text 

 

First, we will focus on animating text. Start by creating a text box in the upper left corner of the workspace 

and write “My Flash Animation”. 

 

Enhance the font size and add boldness to it.  

 

With the box selected go to the Animation Palette.  

 

Here you will be presented with different options and these will shortly be explained.  
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The name tells you which element you are working on. 

 

The Preset menu is where you choose the animation you’d like “MY FLASH ANIMATION” to have. 

Choose Fade In. 

In the top of the menu a butterfly will appear showing you the animation you’ve picked. 

Notice that the settings underneath the preset have become active. Under Event(s) you are able to tell 

InDesign when the animation should appear. The default setting is On Page Load, but it could just as well 

be On Click.  

 

Leave the Event to On Page Load.  

Underneath we have the duration and how many times the animation should be played. We also have the 

possibility to Loop the animation.  

 

Set the duration to last 2 seconds. 

In the bottom of the menu you can choose if the animation should hide before and/or after the animation.  

In the lower left corner of the menu we have this symbol . This is the Preview mode, which lets us see 

what we have created so far, without exporting our document to a flash file.  
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Try the Preview Mode.  This will open the Preview window. 

 

In the bottom you are able to press play  to view the animation again.  

Now you have created your first flash animation.  

 

Animating graphic 

 

Find the picture Airplane.psd in the folder you downloaded on Campusnet.  

Place it by dragging a small frame just outside the workspace.  

 

While selected give it a Move Right preset in the Animation Palette. 

Now your airplane has a green arrow starting from the center of it and pointing towards the center of your 

document. This is the Motion Path for the graphic. Use the Preview Palette to preview the animation. 
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As it looks a bit unprofessional when the plane just stops inside our document, we could try to create our 

own Motion Path instead of using the default ones.  

Go to the Tool Box and select Pencil Tool . Now you can draw a line that the plane can follow.  

When having drawn a line, use the Selection Tool and the Shift Key to add the airplane to the selection.  

 

Then go to the Animation Palette. In the bottom of the Palette you will find this icon  which converts 

your drawing to a motion path.   

Convert your drawing to a motion path. This will change your blue line to a green one. 

 

Notice that the Preset now says Custom (Move right) and it hasn’t deleted the duration setting or that it 

will be started on page load. 

Go to the Preview mode and take a look at your motion path.  

The plane should now be climbing in a more natural way.  

 

Buttons 

Now it is time to create some buttons that enables the viewer to interact with the content.  

Create two similar rectangle frames in the lower part of your document. 

(Remember that holding down the ALT Key while dragging the Frame will duplicate the image) 

Give your frames a fill color. 

In the left frame write “Start the Plane” and in the right “Go to Slideshow”.  
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To get the Start the Plane frame to work as a button that releases the plane, we need to select the plane 

again. 

Then return to the Animation Palette. Next to the Events menu is this icon.  

This icon can be used to create a button trigger for another object. In our example the frame will become a 

trigger button that set off the airplane. 

When using the  icon your cursor changes to a scope. With the scope activated you click on the Start 

the Plane frame. This opens the Buttons Palette. 

 

It has renamed our frame to Button 1 and set the Event to On Release. Underneath we have our actions. 

Right now our button only triggers the animation of the plane but you can always add more functionality to 

the same button later.  

Go to the Preview Palette and check if the button works as intended.  

At the moment the plane is animated on page load and on button release. 
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To remove on page load animation select the airplane and go to the Animation Palette and under Events 

open the menu and select On Page Load to uncheck this animation.  

 

Now Events should only contain On Release.  

 

Preview your animation. 

 

As we created a 2 pages document we also need a button that can move us to page 2. 

This is where our last frame comes into play. Select the frame and open the Buttons Palette. In the bottom 

you’ll find the Convert Object to a Button icon.  By using this icon you’ll convert the object so it can be 

used as a button.  

Notice that it renames our object to Button 2. Change the Event to On Click. Use the  icon to add a 

specific action to your button. Select Go To Page. 

Below this we can choose which page it will go to. Enter 2 instead of 1.  

Unfortunately, you will not be able to view this button function in Preview mode. Instead you need to 

export it to a flash file to control the functionality, but we will not do this until we have created the 

Slideshow on page 2.  

 

Slideshow 

 

It can be a bit tricky to create a slideshow as it involves several actions to get it working in the right way. 

First, go to page 2. 

 

Use the Rectangle Tool  to create a frame and give a Stroke size of 1 pt. 
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Next, use the Rectangle Frame Tool  to make a frame like shown below.  

 

Make it black color and set the opacity to 40%. 

 

 

Duplicate the frame to the right side of the big frame (Use the ALT key while moving the frame) 

 

Now it’s time to add pictures to the white area within our frame.  

Use the Mini Bridge Palette and select Monkey.png and Badge.psd. Drag these images into the workspace 

and place them outside the frame we’ve just created, otherwise you might end up with applying the opacity 

settings to the images.  
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Drag the first picture so it aligns with the top left corner of the white area. 

 

Next drag the frame so it fits the white area. 

 

Use the Centre Content icon  to center the image.  

Repeat the procedure with the Monkey image.  

It might be necessary to use the Fill Content Proportionally icon  as well as Centre Content. 

 

We are able to see both images as they have transparent backgrounds.  
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In order to make them act like a slideshow both pictures should be added to a multi-state object. To do so 

we have to select both images. Unfortunately, it is not possible to select the images given their placement, 

without selecting the frames as well. Instead we can select the images by using the Layers Palette . 

 

When an item is selected in the Layers Palette it will have a color in the square next to its name.  

 

Use the Shift key and click inside the square next to Badge.psd to add it to the selection.  

 

Now both have a blue color. 

Then go to the Objects States Palette to convert our selection to a multi-state object. 

  

Use the icon in the bottom of the menu, to convert it. 

 

The new Multi-state object gets the name Multi-state 1. You can rename the Object Name if you like.  
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Now we only need to add buttons to our graphic, which we can use to click through the slideshow.  

Go to the Sample Buttons Palette. Select 2 arrows; one pointing left and one right. Place the arrow 

pointing left in the middle of the left frame. Repeat procedure to the right.  

 

The final step we need to do is to activate these buttons. 

Go to the Buttons Palette and select the right arrow. It properly already has a premade animation to it 

saying Go To Next Page. Delete it by clicking on this icon.  

 

Instead create a new action by using the plus icon and choose Go To Next State.  

 

Notice, that you are able to choose different Objects below the action. 

Also tick the Stop at Last State, so when clicking through our slideshow it will stop at the last picture. 

 



 

IKT - Advanced Multimedia 

Group 

Marts 2011 

 PERT 

 

 

Side 40 af 40 

 

Repeat the procedure for the left arrow by choosing Go to Previous State and ticking Stop at First State. 

Go to the Preview Palette to see the result.  

 

Finally, we need a way to get back to the first page.  

Add a text frame below the slideshow and write “Go Back” and align center.  

Select the frame and go to the Buttons Palette and convert the object to a button.  

Set Event to On Click and Actions: Go to First Page. 

Save your document as an InDesign file. 

Last but not least Export the document to a Flash File. (File>Export) 

 

Remember to tick off the curling options in the Export SWF menu 

 

Press OK and InDesign should present your flash file in a browser. Make sure all your elements are working 

as intended.  

 

 

 

.: END OF COURSE 2 :. 


